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ABSTRACT
VIBRATION-BASED HEALTH MONITORING OF MULTIPLE-STAGE
GEAR TRAIN AND DIFFERENTIAL PLANETARY TRANSMISSION
INVOLVING TEETH DAMAGE AND BACKLASH NONLINEARITY

by Andrew Patrick Sommer

The objective of this thesis is to develop vibration-based fault detection strategies for on-line
condition monitoring of gear transmission systems. The study divides the thesis into three
sections. First of all, the local stresses created by a root fatigue crack on a pinion spur gear are
analyzed using a quasi-static finite element model and non-linear contact mechanics simulation.
Backlash between gear teeth which is essential to provide better lubrication on tooth surfaces and
to eliminate interference is included as a defect and a necessary part of transmission design. The
second section is dedicated to fixed axis power trains. Torsional vibration is shown to cause teeth
separation and double-sided impacts in unloaded and lightly loaded gearing drives. The transient
and steady-state dynamic loading on teeth within a two stage crank-slider mechanism arising from
backlash and geometric manufacturing errors is investigated by utilizing a non-linear multi-body
dynamics software model. The multi-body model drastically reduces the computation time
required by finite element methods to simulate realistic operation. The gears are considered rigid
with elastic contact surfaces defined by a penalty based non-linear contact formulation. The third
section examines a practical differential planetary transmission which combines two inputs and
one output. Planetary gears with only backlash errors are compared to those containing both
backlash and tooth defects under different kinematic and loading conditions. Fast Fourier
Transform (FFT) analysis shows the appearance of side band modulations and harmonics of the
gear mesh frequency. A joint time-frequency analysis (JTFA) during start-up reveals the unique
vibration patterns for fixed axis gear train and differential planetary gear, respectively, when the
contact forces increase during acceleration.

Keywords: vibration health monitoring, malfunction diagnostics, contact mechanics, contact
forces, numerical simulation, multi-body kinematic model, backlash, profile errors, chipped tooth,
eccentric tooth, planetary gear, epicyclic transmission, joint time-frequency analysis
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1. INTRODUCTION
1.1 Purpose
Mechanical gear transmissions with different designs play very important roles in automobiles,
helicopters, wind turbines, and other modern industries. They transmit both energy and motion
and are typically exposed to various harsh loading conditions. Gear transmissions are often a high
maintenance source due to load variation on the driven machine creating excessive stress on the
gear teeth, and large vibration due to backlash and eccentric teeth. The gearing system is prone to
a variety of potential faults. Without vibration health monitoring to ensure proper operation
performance will degrade.

The General Aviation and Safety Council (GASCo) annual statistics for the UK in 2011 reports
that forty-one percent of helicopter accidents caused by mechanical failure originated with a
malfunction in the gearbox drivetrain. The integrity of helicopter transmission is paramount to
safety because the power train provides propulsion, lift, and flight maneuvering. Fatigue cracks,
material flaws, excessive backlash, and manufacturing errors are often the source of these
catastrophic failures. The sudden events induced by broken teeth release a tremendous amount of
energy stored in the rotating system, sometimes causing components to fail in an explosive
manner. An increased reliability of rotating machinery is needed, while consistent demands from
the power generation and aerospace industries provide financial incentives. Nondestructive
vibration based detection, location, and analysis of damages in the early stages of fault
development play important roles in the health condition monitoring of rotating machinery.

Although sophisticated vibration measurement equipment such as wireless sensors and laser
transducers can detect potential faults early in their progression, it is often difficult to determine
the exact cause of system vibration patterns. The spectrum is complicated by the combination of
different locations of damaged gear teeth, shafts, bearings, and backlash. The design configuration
and location of the transducer also have a significant effect on the available signal for on-line

detection. As a result, dynamic system modeling of gearing transmissions has gained importance
to the advancement of understanding system vibration mechanisms and dynamic behavior in the
presence of both tooth damage and varying backlash. Gearbox transmission systems represent a
complicated non-linear dynamics problem that merits investigation.

1.2 Scope
In the first section, a virtual experiment method based on a quasi-static finite element model and
non-linear contact mechanics simulation is presented. The importance of accurate geometric
modeling of gear tooth involutes and center distance separation on the transient response of ideal
and defective gears is demonstrated. The highly non-linear character of loading and geometry
requires special attention to Hertzian contact modeling. Once modeled accurately, the contact
teeth-pair alternating between one and two and associated stresses are determined, as well as the
effect of a fatigue crack on the pinion root.

The second section demonstrates the transient and steady-state dynamic loading on teeth within a
two-stage gear transmission arising from backlash and geometric manufacturing errors by utilizing
a non-linear multi-body dynamics software model. Double sided tooth impacts and associated
loading are evaluated as well as superposition of effects at a shaft intermediate to sets of gears.
The frequency domain analysis reveals that an eccentric tooth on a gear installed on the
intermediate shaft results in a measureable increase in force magnitude components. The
amplitude of the spectral line at the first-stage gear mesh frequency increases dramatically.

In the third section, a practical differential planetary gear train which combines two inputs and one
output is studied using a multi-body dynamics software model. The backlash between the sunplanet and planet-ring meshes are carefully designed and calculated to avoid teeth interference and
undercut. Tooth profile errors are introduced for comparison to ideal gears. The contact mechanics
model of the meshing teeth is built by careful calculation and selection of the impact algorithm
parameters including the stiffness, force exponent, and damping and friction coefficients.
2

Planetary gears with only backlash errors are compared to those containing both backlash and
tooth defects under different kinematic and loading conditions. Time domain results show that the
dynamic responses depend on the interaction of many components of the differential planetary
system. Fast Fourier Transform (FFT) Analysis shows the appearance of side band modulations
and harmonics of the gear mesh frequency. A joint time-frequency analysis (JTFA) during start-up
illustrates the unique vibration patterns when the contact forces increase during acceleration.
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2. LITERATURE REVIEW
2.1 Fixed axis gears
Dubowsky and Freudenstein [1, 2] developed a theoretical model to investigate the dynamic
response of a mechanical system with clearance. Based on this research, Azar and Crossley [3]
explored the dynamic behaviors of the engaged gearing systems with gear backlash, time-varying
stiffness and damping of the gear teeth. Compared with above investigations, Yang and Sun [4]
developed a more realistic dynamic model for a spur gear system with backlash. By taking the
involute tooth profile into consideration they were able to account for material compliance, energy
dissipation, time-varying mesh stiffness and damping due to the contact teeth-pair alternating
between one and two during the gear engagement cycle. In order to accurately simulate the
dynamic behavior the gear mesh stiffness should include at least two factors: local Hertzian
deformation and tooth bending. Even though the authors only considered the Hertzian contact
stiffness the dynamic simulations for free vibration, constant load operation and sinusoidal
excitation presented insightful results.

Two notable review papers that discuss the numerical modeling of gear dynamics are by Özgüven
and Houser in 1988 [5] and by Parey and Tandon in 2003 [6]. Özgüven categorized the models as
dynamic factor models, models with tooth compliance, models for gear dynamics, those for rotor
dynamics, and those for torsional vibration. The listed goals for the studies included reliability,
life, stress, loading, noise, and vibratory motion. Curiously, condition monitoring was not
included. Early work modeled the meshing stiffness as either an average or piecewise linear
variation. Parey and Tandon’s review concentrated mostly on the modeling of defects but includes
an extensive compilation of various lumped parameter models. Dalpiaz et al. [7] investigated a
gear pair with a fatigue crack and discussed the effectiveness and sensitivity of the timesynchronous average (TSA) analysis and cyclostationary analysis on the basis of experiment. They
also discussed quefrency as a measure of harmonic amplitude in a traditional cepstrum analysis.
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Parey et al. [8] developed a six DOF non-linear model for a pair of spur gears on two shafts,
calculated the Hertzian stiffness for the tooth surface contact, and implemented the empirical
mode decomposition (EMD) method to simulate the different defect widths. Many authors [9, 10,
11, 12] utilized different methods of estimating time-varying stiffness in order to get practical
dynamic simulation results. Meagher et al. [13] presented three different dynamic system
modeling strategies currently being used by researchers to identify diagnostic indicators of gear
health: a strength of materials based lumped parameter model, non-linear quasi-static finite
element modeling, and multi-body kinematic modeling with non-linear contact stiffness. This
research contrasts these methods of modeling gear dynamics by comparing their predicted
stiffness cycle and its affect on dynamic response.

Research shows that the signal patterns due to the combination of backlash, time-varying gear
mesh stiffness, and involute profile errors are complicated and depend on both gear train design
and configuration. In other words, the signals from a specific gearing system are difficult to
interpret until a series of modeling, testing, and data processing work are completed. It is not
feasible to experimentally test each type of gear train for specific fault patterns. To solve this issue
a virtual experiment method based on multi-body dynamics and non-linear contact mechanics is
presented. Ebrahimi and Eberhard [9] used multi-body dynamics software to model gear mesh
stiffness using a rigid-elastic model. Hertzian contact at the gear interface is used to represent
elasticity as a compromise over fully elastic models, thereby reducing computational effort. Kong
et al. [14] modeled a large industrial gearbox used in a twelve cubic meter electric mining shovel.
The non-linear contact mechanics were analyzed to predict the bearing support force variation and
gear tooth loading of ideal gears and those with defects, gear backlash was not considered.

2.2 Planetary gears
The planetary gear train is widely used in transmission design of automobiles, helicopters, and
aircraft engines due to the numerous advantages over traditional fixed axis transmissions. Torque
capability is increased because the load being transmitted is shared between several planets.
5

Another notable advantage of a planetary gear is its distinctive combination of compactness and
high power transmission efficiency. Despite the benefits, the complicated dynamic forces existing
among sun, planet and ring gears are difficult to analyze for sources of vibration. Simulating the
practical dynamic force between single-mating-gear pairs still remains as an important topic. It is
more challenging to realistically model a planetary gear with multiple meshing stages. As a result,
the dynamic analyses of planetary gear trains have received far less attention than fixed axis gear
trains.

Lin and Parker [16] analytically investigate the parametric instability of planetary gears induced
by gear mesh stiffness variation. The authors use rectangular waveforms with different contact
ratios and mesh phasing to simulate the gear mesh stiffnesses existing between sun-planet and
planet-ring mating pairs. Instability boundaries are directly associated with meshing parameters in
the vibration modes. The authors also demonstrate some numerical simulation results about the
teeth separation caused by parametric instability and strong impact in the system response. Lin and
Parker [17] derive a theoretical model and carefully identify the important characteristics of the
natural frequencies and vibration modes for planetary gears. The model uses three planar degrees
of freedom and takes gyroscopic effects and time-varying gear mesh stiffnesses into consideration.
The authors do comprehensive investigations about the distinctive characteristics of each type of
mode. Guo and Parker [18] extended the two-dimensional lumped-parameter model by
incorporating the factors of teeth separation, back-side contact, tooth wedging, and bearing
clearances. By scrutinizing the dynamic response of an example planetary gear the authors
investigate the non-linear tooth wedging behavior often observed in a wind turbine planetary gear
train. More research about dynamic behavior of planetary gears can be found in reference [19, 20].
Unfortunately, the majority of current publications about planetary gears do not include the
interactive effects of backlash and teeth damage.

Even a simplified ideal system model for a one-stage gear train can not accurately simulate the
gear train’s practical dynamic behavior by simply assuming square-waveforms for time-varying
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gear mesh stiffness. The impact forces between the mating pairs are very sensitive to the tooth
profile, and backlash which must be carefully designed. Geometric simplifications used in
classical modeling can be overcome by combining high resolution CAD models with multi-body
dynamic simulation software.
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3. TOOTH ROOT FATIGUE CRACKS INCREASE STRESS IN SPUR
GEAR THROUGH DYNAMIC ENGAGEMENT CYCLE USING
NON-LINEAR QUASI-STATIC CONTACT ANALYSIS
3.1 Model development
Dynamically meshing gear teeth require a high
manufacturing tolerance. An external spur pair
utilizing perfect involute geometry and prescribed
backlash will serve as a baseline model, shown in
Fig.1. A fatigue crack on the root of the pinion gear
is investigated in a second model, shown in Fig.2.
The geometric and material properties of this fixed
axis transmission are calculated in Table 1. The 23/31
spur pair is found in a number of power trains, details
provided in [24]. The elastic modulus and Poisson's
Fig.1. CAD trimetric

ratio are representative of mid-grade throughhardened carbon steel.

MATLAB code is used to generate the tooth involute
profile, shown for the pinion in Fig.3. Backlash
between gear teeth which is essential to provide
better lubrication on tooth surfaces and to eliminate
interference is included as a defect and a necessary
part of transmission design. The most common
Fig.2. Mesh with backlash and
cracked pinion tooth

method to achieve a desired backlash is to increase
the mating center distance between the shaft axes.
Dimensions and prescribed backlash via the center
distance method are calculated in Table 1. Adequate
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thrust bearing capability is assumed in the direction normal to the gear faces. A coupling between
the motor and pinion shaft effectively isolates the gearbox from the driving and driven equipment.

Table 1. Mesh parameters, material properties, and detailed dimensions in inches
Diametral pitch

Pd

10 teeth/in

Pressure angle

Φ

20 degree

Face width

F

1 in

Pinion

Zp

23 teeth

Gear

Zg

31 teeth

Backlash

B

0.004 in

Center distance

c

2.705 in

Contact ratio

mf

1.626
E = 2.07 x 1011
Pa
ν = 0.29
ρ = 7801 kg/m3

Material properties

Pinion

Gear

Dedendum

2.050

2.850

Base

2.161

2.913

Pitch

2.300

3.100

Addendum

2.500

3.300

Operational Radius

1.152

1.553

Two-dimensional finite element stress formulations have shown direct correspondence to the
realistic transmission system. For instance, if the motor supplies 7.5 kW at 950 rpm, the applied
torque becomes,
𝑃𝑖𝑛 = 𝑇𝑝 𝜔𝑝 → 𝑇𝑝 = 667 lb-in
This torque is applied to the pinion shaft diameter by defining a coupling interaction to the
pinion's centerpoint. The gear is held fixed over its shaft diameter in the same manner. The
boundary conditions and loading utilized in all simulations of Chapter 3 are shown in Fig.4.

9

Fig.3. MATLAB generated involute profile for the
23 tooth pinion

The contact mechanics are modeled using the Abaqus/Standard solver algorithm. The interaction
property set surface to surface, finite sliding, hard contact tracking, frictionless tangential
behavior yielded best results. Since gear teeth transmit torque via rolling contact the tangential
behavior of the contact is assumed frictionless. Energy damping inherent in dynamically meshing
gears is negligible. Crack propagation is modeled as a numerical integration of the contour
integrals of fracture mechanics. A 0.03 inch length crack is generated on the root diameter of the
pinion, this is the known fatigue failure location of this external spur gear. The crack front, qvector, and seam are implemented as a Special Engineering Feature, shown in Fig.2 and Fig.5.

A quasi-static stress analysis is performed by rotating both pinion and gear through a series of
different geometrically valid mesh configurations. A pinion rotation of 32º encapsulates a single
tooth passing through the dynamic loading zone, or engagement cycle. By rotating the pinion in 1º
increments, and the gear in corresponding -23/31º increments, the involute surfaces stay in contact

10

at each geometric configuration. Therefore, a total of thirty-two analyses were created for both the
baseline and cracked models.

3.2 Mesh development
The tooth involute profile is a precise
curve best approximated with triangular
elements. Quadratic shape functions
were chosen to ensure that bending
effects were captured in the analysis. A
plane stress formulation with thickness,
t = F = 1 in, was constructed using
element CPS6M of the Abaqus 6.7-3
element library, [25]. CPS6M is a six
noded plane stress triangle with two
translational DOF's per node, shown in
Fig.6.

Fig.4. Shaft diameters are coupled to centerpoints,
surface to surface contact interaction

The fatigue crack was seeded an order
of magnitude larger than the involute
profiles, shown in Fig.5. The faces of
both

gears

were

partitioned

and

appropriate edge biasing applied, shown
for the gear in Fig.7. The convergence
study indicates a refined mesh with a
72744 DOF pinion and a 92344 DOF
gear, shown in Fig.8.
Fig.5. Mesh around pinion crack is
ten times more dense
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All elements used in the baseline model
met the min/max angle and aspect ratio
criteria, no errors or warnings were
observed. Two elements were outside
the suggested min/max angle in the

Fig.6. CPS6M plane stress triangle,
quadrilateral shape functions

cracked model due to the singularity at
the crack tip.

Fig.7. Partitioned gear mesh, element density
required only in the loading zone of interest

3.3 Analysis
A non-linear quasi-static stress analysis is performed on a model with a perfect mesh and a mesh
with a cracked pinion tooth. The contact force tolerance parameter was adjusted to 0.001 in. This
parameter defines the distance between surfaces in which the solver assumes contact. According to
[25], a value greater than zero increases the algorithm's accuracy and decreases computational
time. The tolerance value is four times less than the backlash arclength of 0.004 in, the smallest
characteristic length in the system.

3.4 Mesh convergence
The convergence study reveals a strong linear relationship between maximum Von-Mises stress
and model DOF, shown in Fig.8. This result is due to the geometric stress concentration at the
tooth root. Decreasing the element size (increasing model DOF) creates a smaller area for the
bending force to act upon, causing an increase in stress. The number of fixed nodes along the
surface representing the gear shaft does not change because the region is coarsely meshed.
Therefore, the model DOF is calculated as,
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𝐷𝑂𝐹 = 2 ∙ (𝑡𝑜𝑡𝑎𝑙 𝑛𝑜𝑑𝑒𝑠 − 𝑛𝑜𝑑𝑒𝑠 𝑓𝑖𝑥𝑒𝑑 𝑏𝑦 𝐵𝐶) = 2 ∙ (𝑡𝑜𝑡𝑎𝑙 𝑛𝑜𝑑𝑒𝑠) − 110

Fig.8. Von-Mises stress proportional to model DOF due to geometric
stress concentration at the tooth root

Convergence results of this type are anticipated in models with discontinuous geometric stress
concentrations such as those on the root diameters of this spur gear. One approach is to tune the
element size such that a desired stress value is achieved. A 164,868 DOF model was selected
because the predicted maximum stresses were near those obtained by classical methods.

3.5 Results
The maximum Von-Mises stress predicted by the finite element model is in close agreement with
classical equations, shown in Fig.9. The Lewis-bending equation and AGMA methodology were
used to predict the bending stress, details provided in Appendix A. The results of the Lewisbending equation are σLewis = 33.7 ksi.
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Fig.9. Maximum Von-Mises stress through the engagement cycle predicted by
perfect and cracked non-linear quasi-static finite element models

(a) Pinion at 3º with prefect geometry
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(b) Pinion at 8º with perfect geometry
Fig.10. Contact teeth pair alternating between (a) one, and
(b) two during the gear engagement cycle

Fig.11. Crack propagation with pinion at 21º

Close agreement between model and theory should be considered with respect to the convergence
behavior created by the geometric stress concentration. The inclusion of the pinion root crack
represents a characteristic increase in force and resulting stress magnitude between the perfect and
damaged geometries.
15

The contact teeth-pair alternates between one and two during the gear engagement cycle, shown in
Fig.10. The gear contact ratio ( mf = 1.626 ) can be observed graphically the regions indicated in
Fig.9. A root crack on the pinion has created a 99% stress increase at the single-tooth tip-contact
position occurring at pinion 21º, shown in Fig.11.

3.6 Discussion
Fatigue failure due to cracked or chipped teeth is one of the most common failure modes of
industrial transmission. Many engineering sectors have active research in gear fatigue and
conditional health monitoring through vibration diagnostics. A broad range of fixed axis external
spur gear designs can be investigated using the CPS6M plane stress element and surface to surface
contact algorithm parameters presented in Chapter 3. The quasi-static formulation can be used to
extract the linear tooth mesh stiffness of this spur pair, then convert to a torsional mesh stiffness
by defining the centerpoint angular rotations as a function of time. This value can be compared
directly to experimentally obtained results in the next stage of the finite element analysis effort.
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4. GEAR DEFECT MODELING OF A MULTIPLESTAGE GEAR TRAIN

4.1 Multi-body kinematic model of a one-stage gear train
A rigid-elastic model of a pair of meshing gears is
shown in Fig.12, details provided in [24]. Fig.13
shows an eccentric pinion with a chipped gear. The
gears are rigid but the contact surfaces are modeled
using a penalty based non-linear contact formulation.
The non-linear contact force, 𝐹 = 𝐾(𝑑)𝑒 − 𝑐𝑣, is

composed of an elastic and damping portion [15],

where d is the penetration depth. The damping force,
Fig.12. A pair of meshing gears

cv, is proportional to impact velocity, v.

The stiffness coefficient, K, is taken to be the average value of stiffness over one tooth mesh cycle.
The force exponent, e, was determined from trial simulations. The damping coefficient generally
takes a numeric value between 0.1% - 1% of K. The determination of force exponents however is
not obvious and must be based on experience. The ADAMS impact algorithm was chosen as the
contact model because of its robustness in numerical integration. The restitution model is
extremely sensitive to the duration of the contact event and is best suited for impulse type
simulations. It is not optimal for time histories that include a large number of contact events in
which the force vector is not known beforehand.

The stiffness parameter is reasonable for the lightly loaded medium steel pair. The response of
interest occurs over a very short time interval, around one hundred milliseconds. Because damping
in meshing gears is such a small percentage of the elastic force, its affect on the simulation results
is negligible. Therefore, the damping coefficient is near zero to simplify the numerical solver
routine.
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Fig.13. Eccentric pinion tooth with chipped gear

The penetration dc is defined as the depth at which the damping force reaches its maximum value,
details provided in [15]. Modification of this value does not have a significant effect on the
response of either gear. The geometric mesh parameters and ADAMS contact parameters are
shown in Table 2.

Table 2. Geometric parameters and
simulation contact force
Algorithm

ADAMS impact

Stiffness

K

2 x 107 lb/in

Force Exponent

e

2.2

Damping

c

2 x 10-2 lb-s/in

Penetration

dc

1 x 10-7 in

Diametral Pitch

Pd

10 teeth/in

Pressure Angle

Φ

20 deg

Face Width

F

0.5 in

Pinion

Zp

23 teeth

Gear

Zg

31 teeth

Backlash

B

0.004 in

Contact ratio

mf

1.626

The eccentric pinion and chipped gear geometries are generated by modifying the involute profile
of a single tooth. The tooth chip is created by removing mass from the ideal form. Tooth
eccentricity by rotating the profile along the base circle by an angle that does not cause mesh
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interference. From the defined gear backlash the operational center distance of the spur pair is 𝐶 =
2.705 in, details provided in [21].

4.2 Simulation results and discussions
Combined with gear profile errors backlash may cause loss of contact between gear teeth. This
may induce consecutive single-sided or double-sided impacts and generate large impact forces
with large vibration. Rp and Rg are the radii of the base circles of pinion and gear, respectively.
The relative displacement between the two mating teeth profiles along the line of action is
represented as, 𝑆 = 𝑅𝑔 𝜃𝑔 − 𝑅𝑝 𝜃𝑝 , shown in Fig.14. When S is larger than the gear backlash B,
there is contact between pinion and gear. For a fixed axis external spur pair,
−𝐵 ≤ 𝑅𝑔 𝜃𝑔 − 𝑅𝑝 𝜃𝑝 ≤ 𝐵

𝑹𝒈 𝜽𝒈 − 𝑹𝒑 𝜽𝒑 = −𝑩

𝑹𝒈 𝜽 𝒈 − 𝑹𝒑 𝜽 𝒑 = 𝟎

𝑹𝒈 𝜽 𝒈 − 𝑹𝒑 𝜽 𝒑 = 𝑩

Fig.14. Relative displacement along the line of action, 𝑺 = 𝑹𝒈 𝜽𝒈 − 𝑹𝒑 𝜽𝒑

Fig.15 shows relative displacement S along the line of action with pinion initial velocity ωinput =
100 rad/s for a perfect meshing pair and a pair with an eccentric tooth on the pinion. A back
collision takes place during separation of the gear teeth. Successive double-sided impacts are
observed on the alternating surfaces of the meshing pair. The early motion of Fig.15 is outside ± B
because of the surface penetration required by the impact algorithm. As time increases the
penetration decreases, and the period between impacts increase for both the perfect and eccentric
gear pairs.
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Each point of Fig.15 defines a unique tooth configuration of the mesh. The profile error of the
eccentric pinion tooth causes a greater number of oscillations to occur in a given time interval.
This can be explained by considering that the tooth is larger, and therefore has less space to move
within the backlash band ± B. During startup the eccentric pinion tooth will contact the mating
gear tooth earlier than it would with the ideal profile geometry. The frequency of impact has
increased.

Fig.15. Relative displacement S along the line of action with
pinion initial velocity ωinput = 100 rad/s
Fig.16 plots the angular velocity of the gear for both a perfect and chipped pair with pinion initial
velocity and constant applied torques. As contact with the gear occurs both the pinion and gear
velocities change rapidly. The large magnitudes during the first 20 ms are due to the pinion's
prescribed initial velocity. This transient response decays quickly and only the effect of the
applied torques are observed. Both the pinion and gear experience single-sided impacts.
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Fig.16. Angular velocity of the pinion with initial velocity 100 rad/s; 3 lb-in torque
applied to pinion; -3 lb-in torque applied to gear

The effect of the chipped tooth with respect to the number of impacts is opposite to that of the
eccentric tooth. It takes longer for the pinion to make contact with the gear because of the
modified profile. Close inspection shows that the chipped gear experiences less direction changes
than the perfect gear, and therefore less impacts. The chipped tooth creates a time lag in the
angular velocity response as it moves through the dynamic engagement cycle.

4.3 Multi-body kinematic model of crank-slider mechanism with
two-stage gear train
In order to investigate how the interaction of backlash and manufacturing errors affects the
dynamic behavior and contact forces of a multiple-stage gearing system, the crank-slider
mechanism shown in Fig.17 is studied. Fig.18 depicts the gearing transmission for the mechanism.
The gear design and simulation parameters are calculated in Table 3 and Table 4, respectively.
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Table 3. Design parameters

Number of teeth

Pitch diameter mm
Module

Table 4. Simulation parameters

Za = 17; Zb = 60;
Zc = 19; Zd =72

Material properties

Da = 68; Db = 240;
Dc = 95; Dd =360

Force exponent

m1 = 4; m2 = 5

Backlash mm

Gear ratio

13.4

Penetration

Pressure angle

20°

Stiffness

Fig.17. Crank-slider mechanism

Fig.18. Two-stage gear train
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E = 2.07 x 1011 Pa;
ν = 0.29;
ρ = 7801 kg/m3
2.2
B1 = 0.05; B2 = 0.08
10-7 mm
2 x 107 N/mm

(a)

(b)

Fig.19. Geometric defects including (a) chipped tooth of Gear A,
and (b) eccentric tooth of Gear C

The ADAMS impact algorithm was chosen for this multi-body dynamic analysis. The chipped
tooth of Gear A is created by removing the mass of a single tooth, shown in Fig.19(a). An
eccentric tooth on Gear C is generated by linearly translating the involute profile 0.0045 mm from
the perfect geometric position, shown in Fig.19(b).

4.4 Transient response after power loss
The perfect waveform shown in Fig.20 is the response of all four gears with perfect involute
profiles and prescribed backlash. The chipped curve is the response of an input pinion with a
chipped tooth, all other gears have ideal profiles. The coordinate orientation is defined such that a
force from the pinion to the gear is considered positive. This simulation emulates the dynamics
and loading conditions of a system coast-down. The coast-down is characterized by the
mechanism slowing from steady-state speed to rest in a short time interval. An initial velocity is
prescibed on each shaft that corresponds to its rotary speed under standard operating conditions.

From the top two plots of Fig.20, the initial position of the gears is such that neither stage is in
contact at the beginning of the simulation. Thsi follows from the assumption that with loss of
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power there will be separation of teeth due to sudden load removal and inertial effects. Therefore,
all three shafts are rotating without impact until Gear C touches Gear D at 11.4 ms. Gear A
touches Gear B at 14.7 ms, it causes the contacts in Stage 1 to inrease in frequency for the next 20
ms. The angular velocity of the intermediate shaft is a combination of the other two shafts' angular
velocities. Double-sided impacts are evident in the y-component of force in Stage 1. When the
sign of the force alternates at similiar magnitude, it indicates impacts on the same tooth in
alternate directions. The dynamic response of the intermediate shaft is due to a superposition of
the impacts in Stage 1 and Stage 2.

Fig.20. Free vibration response with input shaft, 167.5 rad/s;
intermediate shaft, -73.5 rad/s; output shaft, 12.5 rad/s

For the chipped pinion the first impacts in Stage 1 occur earlier. This is due in part to the reduction
of intertia. The interia of the perfect input pinion is Izz = 1.06 x 10-3 kg-m2, while the chipped
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pinion is Izz = 1.04 x 10-3 kg-m2, a reduction of 1.76%. The chipped pinion will experience larger
acceleration for a given force. The teeth neighboring the chipped tooth will contact the mating
gear sooner than they would with their standard inertia.

Fig.21 depicts the force response in Stage 2. The first and second contacts occur at nearly the same
instant for both the perfect and chipped geometries. Gear D experiences three single-sided impacts
during the interval for the perfect case, and only two for the chipped pinion. The force magnitude
in Stage 1 is reduced during the interval 20 < t < 28 ms as the chipped tooth of Gear A moves
through the engagement cycle.

Fig.21. Comparison of the force magnitudes in Stage 1 and Stage 2 with initial
conditions: input shaft, 167.5 rad/s; intermediate shaft, -73.5 rad/s;
output shaft, 12.5 rad/s

The initial velocities given to each shaft are based upon their rated operating speed. The shaft
bearings are modeled without friction and constrain all degrees of freedom except for rotation in
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the normal plane. The relative pitch velocity of Gear C and Gear D is slightly larger than between
Gear A and Gear B, causing the first contact event to occur in Stage 2 before Stage 1. If the
relative velocity between Gear A and Gear B was larger than between Gear C and Gear D, then
the timing of the initial contact would be reversed. The delay in the response of Stage 2 around
18.5 ms is due to the chipped tooth on Gear A.

There are three bodies undergoing rotation in the multi-body dynamic model of the crank-slider
mechanism. The first is the input shaft and Gear A; the second is Gear B, the intermediate shaft,
and Gear C; the third is Gear D, the output shaft, and the crank. The intertial mass of the third
body is over one order of magnitude larger than the other two bodies. Its velocity changes slower
than the other two bodies due to intertial effects.

Fig.22. Relative displacement S along the line of action in Stage 2 with
the initial conditions: input shaft, 167.5 rad/s; intermediate shaft,
-73.5 rad/s; output shaft, 12.5 rad/s
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Fig.22 shows the relative displacment between Gear C and Gear D in Stage 2. A point on this plot
defines the position within the engagement cycle of Gear C and Gear D. The contacts in Stage 1
create high frequency oscillations in the angular position of Gear C. The large scale motion of
Gear C is due to the impacts in Stage 2 as Gear C rotates between the teeth of Gear D. The
quantity 𝑆 = 𝑅𝑔 𝜃𝑔 − 𝑅𝑝 𝜃𝑝 for Stage 2 appears as a jagged line. The small oscillation is a direct

result of the contact forces in Stage 1. When Gear C makes contact with Gear D the response
becomes smoother. The oscillation remains intact but the speed of Gear D changes rapidly,
making these small position changes more difficult to identify. The entire S curve is shifted
forward in time when a chipped tooth is present on the input pinion. Although the impacts in Stage

1 occur earlier the overall behavior of Stage 2 is delayed. The profile error causes Stage 1 to
become excited, and as a result it takes longer for the contact in Stage 2 to occur.

4.5 Start-up simulation
A realistic step torque of the form 𝑇(1 − 𝑒

𝑡�
𝜏)

is applied to the input shaft with amplitude of 149.1

N-m at τ = 1 s, to simulate a start-up accelerating condition. The step function represents the
characteristic curve of an electric motor.

The gears of each mesh come to an equilibrium position in which they remain in contact, shown in
Fig.23. This is a physical constraint which must be satisfied for the system to transmit power. The
driving teeth approach the surface of the driven teeth, and oscillate with less amplitude as time
increases. Stage 1 has the more drastic decrease in amplitude. The S waveforms of each mesh
approach the surfaces indicated. The distance to each surface corresponds to the prescribed
backlash of each stage.
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Fig.23. Comparison of relative displacements S along the line of action in
Stage 1 and Stage 2 with step input torque 149.1 N-m

Fig.24. Comparison of the force magnitudes in Stage 1 and Stage 2
with step input torque 149.1 N-m
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The impacts in both stages increase in magnitude and occur at increasingly shorter intervals of
time, shown in Fig.24. The force in Stage 2 is larger because Gear D is being driven by the torque
on the input shaft through the gear action of Stage 1. The large inertia must be overcome solely
with the force in Stage 2. Therefore, the impacts in Stage 2 are a direct result of the impacts in
Stage 1. Since energy damping is negligible, each Stage 2 impact is a summation of the
preceeding impacts in Stage 1. The trends in both contact forces continue up to t = τ. For t > τ the
torque on the input shaft becomes constant and continues to drive the system to steady-state.

Fig.25. Three dimensional FFT of force magnitude in Stage 1 for prescribed backlash and
perfect geometry with exponential step torque 149.1 N-m on the input shaft
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In order to demonstrate how the frequency contents of the contact force evolve over time, a joint
time-frequency analysis (JTFA) is presented based on transient start-up conditions. For this
procedure aliasing issues are prevented by using a large number of integration steps and a long
simulation duration of 3 seconds. Spectrum leakage was reduced by overlapping a sliding time
sample of 50 ms by 80% and applying a Hamming window to each sample.

The spectral components of the force in Stage 1 exhibit the exponential form of the applied input
torque, shown in Fig.25. The system passes its rated operating speed around 350 ms and continues
to accelerate under a start-up condition. The dominant frequencies are the three shaft spin speeds
and the two gear mesh frequencies. Because the mesh pairs do not share a common factor only
integer multiples of the superharmonics are considered. The largest spectral line is the first gear
mesh frequency, GMF1 = 1653 Hz, and the second largest is its first superharmonic, 2(GMF1) =
3306 Hz. The lines which originate below 100 Hz are the element spin speeds and their harmonics.
The largest spin speed amplitude corresponds to the input pinion 1X which has a value of 98 Hz at
t = 600 ms. An exponential increase in the magnitudes of each frequency line is observed, a
characteristic which is not readily available in standard two dimensional plots. Fig.25 shows the
trends of the transient magnitude and frequency components of the contact-dynamic force over the
short time interval.

4.6 Steady-state frequency domain analysis
To obtain the frequency domain response of Stage 1 a constant angular speed is applied to the
input shaft and a small resistive torque on the intermediate and output shafts, shown in Fig.26(a).
The magnitude of the resistive torque is around one percent of the element's torque at steady-state.
The resistive torques model the rotational friction due to bearings, couplings, and fluid shear in the
realistic crank-slider mechanism. In addition, this torque decreases any large variations in force
amplitude, producing a type of filter for the signal of interest in the time domain. Aside from the
resistive torque on each element the system is not loaded and the resulting spectral magnitudes are
below 1 kN. The frequency response of Stage 2 is obtained by assigning the output shaft a
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constant angular speed, and a resistive torque on the input and intermediate shafts, shown in
Fig.26(b).

(a)

(b)
Fig.26. A comparison of frequency domain components of force magnitude in (a)
Stage 1 and (b) Stage 2 with prescribed backlash and perfect geometry

The frequency components in each mesh include the gear mesh frequencies and their
superharmonics. The shaft speeds and hunting tooth frequencies are absent because the perfect
mesh geometry contains prescribed backlash without profile errors. If the frequency components
under 100 N are noise, then the first five harmonics of the gear mesh frequency comprise nearly
all the total force vectors.

For Fig.26, the Stage 1 initial conditions are input shaft, 26.7 Hz; intermediate shaft, -5.27 N-m;
output shaft, -20.0 N-m. The Stage 2 initial conditions are input shaft, -1.49 N-m; intermediate
shaft, -5.27 N-m; output shaft, 1.99 Hz. The coupled contact behavior in Stage 1 and Stage 2 are
evident in the frequency domain as sideband modulation. The force vector in Stage 1 is modulated
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by the output 1X at 1.99 Hz creating small sidebands surrounding the gear mesh and its
harmonics, shown in Fig.26(a). Similarly, the force vector in Stage 2 is modulated by the input 1X
at 26.7 Hz. This creates the larger sideband modulations around the gear mesh and its
superharmonics, shown in Fig.26(b).

Fig.27. Frequency domain components of the force magnitude in Stage 2 with an
eccentric gear tooth on Gear C with initial conditions: input shaft, -1.49 N-m,
intermediate shaft, -5.27 N-m; output shaft, 1.99 Hz

The presence of an eccentric tooth on Gear C creates an increase in force magnitude components
below the gear mesh frequency, shown in Fig.27. The eccentric tooth comes into mesh once per
revolution causing excitation at intermediate 1X = 7.6 Hz ( fi ) and its superharmonics. The
influence of this low spin speed excitation decreases as frequency increases. The perfect and
eccentric spectra are nearly identical after the first harmonic of the gear mesh frequency. The
eccentricity of Gear C causes the amplitude of the spectral line at GMF1 to increase by 50.4%.
This is a potentially new and important vibration signature of the defected gear train.
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5. TOOTH CONTACT FORCES AND DYNAMICS IN A
DIFFERENTIAL PLANETARY GEAR WITH
BACKLASH AND TEETH DAMAGE

5.1 Modeling a differential planetary gear train with backlash and teeth damage
The differential planetary gear chosen for study has two inputs and one output [21, 22, 23]. The
system schematic and CAD model are shown in Fig.28(a) and Fig.28(b), respectively. The profile
of the chipped sun gear tooth is shown in Fig.29. Geometric design parameters of this planetary
transmission are calculated in Table 5.

(a) Schematic

(b) CAD isometric

Fig.28. A differential planetary gear with two inputs and one output,
the ring has both internal and external teeth

Combined with profile errors, backlash may cause loss of contact between gear teeth. This may
induce large impact forces associated with consecutive single-sided or double-sided impacts. The
gears are rigid with contact surfaces defined with a penalty based non-linear contact formulation in
the same manner as Chapter 4. The contact force, 𝐹 = 𝐾(𝑑)𝑒 − 𝑐𝑣, is a vector quantity composed
of an elastic and damping portion [15], where d is the penetration depth. The damping force, cv, is

proportional to impact velocity, v. The stiffness coefficient, K, is taken to be the average value of
stiffness over one tooth mesh cycle. The force exponent, e, was determined from trial simulations.
The damping coefficient generally takes a numeric value between 0.1% - 1% of K. The
determination of force exponents however is not obvious and must be based on experience.
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Table 5. Design and simulation parameters

Number of teeth

Pitch diameter
mm
Module

Za=20; Zb = 94
Zc= 37; Z1 =28
Z2 = 98

Material properties

Da= 40; Db = 188
Dc=74; D1 =56
D2 = 196

Force exponent

2

Gearing ratios

5.7; 1.213

Pressure angle

20º

Backlash
Penetration
Stiffness

E = 2.07 x 1011 Pa;
ν = 0.29;
ρ = 7801 kg/m3
2.2
B1 = 0.04 mm
B2 = 0.03 mm
10-7 mm
2 x 107 N/mm

Table 6. Dynamic conditions depicted in the Figures of Chapter 5
Fig. No.
31, 32
33, 34, 35
36, 37, 38
39, 40, 41(a)
41(b), 42

Simulation Parameters
ωx0 = 100 rad/s initial angular velocity applied to the carrier, fixed ring
ωx0 = 100 rad/s initial angular velocity applied to the carrier, free ring
ω1 = 102.1 rad/s constant angular velocity applied to the sun, fixed
i
T1 = 70.5 N-m step torque applied to the sun, fixed ring
T1 = 70.5 N-m step torque applied to the sun,
T2 = 67.9 N-m applied to gear 1

Fig.29. Chipped tooth profile

The ADAMS simulation parameters are shown in Table 5. As a reference, the dynamic conditions
presented in the Figures of Chapter 5 are shown in Table 6.
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5.2 Dynamic response and discussion of a planetary gear with a fixed ring
A brake is applied to the Motor 2 input shaft which effectively fixes both the ring and gear 1. An
initial angular velocity, ωx0 = 100 rad/s is applied on the carrier, shown in Fig.30. In order to be
dynamically feasible the sun and carrier rotate in the same direction, and the planets in the
opposite direction. The response of the planet rotations are nearly identical. Their axes are coupled
to the rotating carrier, and therefore the planets make contact with both the sun and ring at nearly
the same instant. Identical dynamics are observed when an initial angular velocity is applied to the
sun instead of the carrier.

Fig.30. Angular velocity when initial angular velocity
ωx0 = 100 rad/s is applied to the carrier
A nearly symmetrical position is used for all simulations presented in Chapter 5. To evaluate the
utility of this initial position consider the transmission in an exactly symmetrical orientation. The
planes of the sun and ring are parallel and each planet is in the exact center of the backlash space
between the sun and ring meshes. From this position the response of each planet is identical
because contact occurs at exactly the same instant for all three elements. To be more realistic this
symmetrical initial position is deliberately avoided. Instead, the sun, planets, and ring are
displaced from 𝑆 = 𝑅𝑔 𝜃𝑔 − 𝑅𝑝 𝜃𝑝 = 0. This ensures contact occurs on each planet will occur at

different times, and the response of Fig.31 can be simulated. The nearly symmetrical position
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creates the difference in contact force magnitudes on each element. These force vectors dictate the
system dynamics of the planetary transmission.

Fig.31. Contact forces when initial angular velocity
ωx0 = 100 rad/s is applied to the carrier
Consider the duration in Fig.31 when two or more planets experience nearly identical forces. They
are load sharing and are both in contact with either the sun or ring. For discussion, the planets are
given a designation of either 1, 2, or 3, respectively. Between 5 and 15 ms planet 1 is the only
planet in contact with the sun, therefore planet 2 and planet 3 are traveling within their backlash.
During the same interval planet 1 is not in contact with the ring. The ADAMS model includes six
contact forces: three on the sun from each planet, and three on the ring from each planet. At any
given instant, no force or any combination of all six forces are potentially active. The small
damping prescribed in the contact formulation causes the pattern between 0 and 30 ms to slowly
reduce in amplitude with time.
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5.3 Dynamic response and discussion of a planetary gear with a free ring
Two planar DOF are added to the model by unconstraining both the ring and gear 1 and allowing
them to freely rotate. The initial velocity of the carrier is transferred into all of the transmission
elements instead of only the sun and planets as with the fixed ring. The rotation of the ring's large
inertial mass causes several phenomena.

The transmission elements no longer oscillate with the same frequency with respect to the initial
position. From Fig.32, the system returns to its initial position at 93 ms instead of the much shorter
period of 20 ms shown in Fig.30. The sun, planets, and carrier elements share the same period of
27 ms because these elements are physically coupled together. Similarly, the rotation of gear 1 is
physically coupled to the ring, and they share the longer period of 93ms. The rotation of the ring
has increased the system period by a factor of 3.44.

Fig.32. Angular displacement when initial angular velocity
ωx0 = 100 rad/s is applied to the carrier
Vibration increases when an element reverses direction, shown in Fig.33. This is because of the
time delay created by the change inertial resistance. With the fixed ring, the sun makes contact
with a planet, and that planet makes contact with the ring. When the ring is allowed to rotate the
sequence includes two new elements. The sun makes contact with a planet, the planet makes
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contact with the ring, and the ring makes contact with gear 1, which is itself freely rotating.
Therefore, only inertias are contributing to the change in angular velocity because all elements are
unconstrained. Between 25 and 35 ms the sun makes contact with the planets. The impact of the
sun makes a larger change in the planet's rotation than if the ring was stationary. The end result is
a longer angular velocity settling time as the sun converges to 250 rad/s during 27 to 37 ms.

(a)

(b)
Fig.33. The (a) angular velocity, and (b) contact forces when initial angular
velocity ωx0 = 100 rad/s is applied to the carrier
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The magnitude of the contact forces is shown in Fig.33(a). A comparison with Fig.31 yields
several conclusions. The first significant impact occurs at an earlier time relative to the fixed ring
configuration. The interval in which the impact takes place has also decreased. For example, the
sun and planet 2 are in contact for the first 20 ms in Fig.31, but remain in contact for 15 ms in
Fig.33. When the sun approaches planet 2 the ring is rotating away from the direction of contact,
resulting in a shorter impact duration than for the fixed ring. The general characteristic of the
curve remains intact, only the duration of the event has changed.

5.4 Dynamic response and discussion of a planetary gear with
constant velocity from the sun
The ring is held fixed and the sun is being driven by Motor 1 which has a constant angular speed
of 102.1 rad/s = 975 rpm. Fig.34 shows the magnitude of each element's angular velocity. The
planet gears must be rotating in a direction opposite that of the sun and carrier for the engagement
to be dynamically feasible. During the first few milliseconds the angular velocities change rapidly,
then converge to an average speed consistent with their respective gearing ratios.

Fig.34. Angular velocities when constant angular velocity
ω1 = 102.1 rad/s is applied to the sun
The planet inertia is much smaller than the carrier assembly. Since the planets experience forces
from the sun and internal ring, their angular velocities have a larger change in amplitude. These
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oscillations reduce quickly because the system is being driven by the kinematic constraint of a
constant angular speed, which defines angular velocity ω as a function of time, ω = ω(t).
Therefore, the sun will have the prescribed motion regardless of any force it experiences, causing
the system to reach steady-state rapidly.

Fig.35. Sun-planet contact force when constant angular velocity
ω1 = 102.1 rad/s is applied to the sun

Fig.36. Angular velocities when constant angular velocity
ω1 = 102.1 rad/s is applied to the sun
The sun and planet 1 share a force history with several distinct patterns, shown in Fig.35. The two
largest peaks are when the sun is in contact with only one planet. Two planets account for the next
four largest peaks, and the three peaks around 20 ms are when all three planets are in contact with
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the sun. The force between the sun and this particular planet is reduced when the sun is in contact
with other planets, depicting the dynamic nature of the sun contact ratio.

Consideration of a sun with a chipped tooth is shown in Fig.36. Between 1 and 3 ms the
magnitude of the angular velocity has increased. This is because the planet has more room to
move in the larger backlash induced by the damaged tooth. An impact force causes a change in
angular acceleration which propagates further because of the profile gap. The response of the
perfect involutes and chipped planets become nearly identical after 10 ms because the damaged
tooth has moved through the engagement cycle.

5.5 Dynamic response and discussion of a planetary gear with a
step torque applied to the sun
With a fixed ring, a realistic step torque of the form 𝑇(1 − 𝑒

𝑡�
𝜏)

is applied to the sun input shaft to

represent an electric motor, with magnitude and time constant derived from rated conditions.
Compare the contact force magnitude of Fig.37 with Fig.35. The first large magnitude occurs at 9
ms for constant input speed, while the same magnitude here does not occur until 25 ms. An
applied torque creates an angular acceleration which acts against the resistive inertia of the sun.
This causes the force response to become delayed relative to the constant speed case. The largest
magnitudes occur when this planet is the only planet in contact with the sun. The smaller
magnitudes are due to the load sharing resulting from the dynamic sun contact ratio. The chipped
sun experiences fewer impact events than the sun with standard involute profiles, shown in Fig.38.
It takes longer for the gears to contact due to the damaged tooth. The chipped sun experiences
larger velocity changes because the torque has accelerated the sun for a longer time before contact.
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Fig.37. Sun-planet contact force when the torque
T1 = 70.5 N-m is applied to the sun

Fig.38. Sun angular velocity when the torque
T1 = 70.5 N-m is applied to the sun
These velocity changes create large force magnitudes. The oscillations dissipate quickly as the
system accelerates and contact between gear teeth becomes constant along one side only. Velocity
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changes from positive to negative, like those shown in Fig.38, represent double-sided impacts
induced by torsional vibration.

5.6 Dynamic response and discussion of a planetary gear with a
step torque applied to both the sun and gear 1
The system is operating in differential mode with Motor 1 and Motor 2 operating in the same
direction. A step torque of the form 𝑇(1 − 𝑒

𝑡�
𝜏)

is applied to both the sun and gear 1 to represent

an electric motor, with the magnitude and time constant derived from rated conditions.

With a fixed ring as in Fig.39(a), the sun exhibits the form of the step function used to model the
input torque. The sun oscillates with the largest amplitude because it has the smallest inertia. The
planets dissipate energy from the sun input to the carrier output. The three planets must accelerate
the carrier's large inertia from rest. The amplitude of the sun's velocity change is reduced with the
system operating as a differential transmission, shown in Fig.39(b).

(a) Fixed ring, T1 = 70.5 N-m
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(b) Free ring, T1 = 70.5 N-m, T2 = 67.9 N-m
Fig.39. Angular velocity with applied step torques

Fig.40. Angular velocity when torque T1 = 70.5 N-m is applied to the sun
and T2 = 67.9 N-m is applied to gear 1
Operating in the differential mode the ring and carrier move in the same direction as the applied
torque on the sun. This makes the magnitude of the sun's angular velocity change more smooth
compared to the simple planetary configuration with a fixed ring. The same effect is seen in the
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other elements. The detrimental effects of the sun's chipped tooth are reduced with the system
operating in the differential mode.

The mesh between gear 1 and ring has a smaller prescribed backlash than the sun and planet
meshes. Therefore, contact occurs in this external fixed axis mesh before the sun and planets. A
clear succession of impacts shown in Fig.40. The interval from 3.5 ms to 4.5 ms shows that as
gear 1 contacts the ring, the ring contacts a planet, and the planet contacts the sun. The planets can
simultaneously be in contact with the sun and ring. This complication means that the force in the
fixed axis mesh directly affect the magnitude of the force between a planet and ring, shown as the
10 N peak at 7.5 ms. The dynamic response of the planet is due to a superposition of the impacts
in its sun and ring meshes.

5.7 Steady-state frequency domain simulation results and discussion
The system is operating in the differential mode, with Motor 1 and Motor 2 operating in opposite
directions. Constant angular velocities of 16.3 Hz = 975 rpm, and -12.4 Hz = 745 rpm, are applied
to the sun and gear 1, respectively. A small resistive torque is applied to both the ring and carrier
assembly. The value of the resistive torques are around one percent of the element's torque at
steady-state. This resistive inertia models the frictional torque generated by the bearings,
couplings, and fluid shear of the realistic planetary transmission. For testing purposes, a standard
feedback control system can maintain the constant input speed on both shafts.

The predicted spectrum includes harmonics of gear mesh frequencies and element spin speeds.
Predicted frequencies up to 1000 Hz are calculated in Table 7. The sun, planet, and internal ring
share the same planetary gear mesh frequency denoted as GMFabc. The fixed axis mesh between
gear 1 and the ring (gear 2) is denoted as GMF12. This fixed axis mesh is characterized by a
common factor of 14, therefore the n/CF subharmonics are included in the predicted spectrum.
The abc12 naming convention is consistent with the schematic of Fig.28(a). Both the planetary
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and fixed axis meshes have unique force histories when the transmission is operating in the
differential mode, shown in Fig.41 for prescribed backlash and ideal involute profiles.

Fig.41. Time and frequency domain representations of force
in the planetary and fixed axis meshes

The fixed axis mesh between gear 1 and gear 2 is independent from the coupled kinematics of the
planetary meshes. The largest amplitudes correspond to the gear meshing frequencies. The
sidebands in the planetary mesh are modulations of sun spin speed because the sun is driven by
Motor 1. Similarly, sidebands in the fixed axis mesh are modulated by the gear 1 spin speed
because it is driven by Motor 2. The time and frequency domains of each mesh are shown in
Fig.41.
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(a)

(b)
Fig.42. Force magnitude in planetary mesh elements include (a) spin speed
components, and (b) modulated gear mesh frequencies
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Table 7. Theoretical frequencies for the
differential operating mode in Hz
Frequency

Spin Speed

1X

2X

3X

GMFab

209

419

628

Ring

GMF12

347

695

1042

Carrier

1/14

25

50

74

Planet

2/14

50

99

149

Gear 1

3/14

74

149

223

Sun

4/14

99

199

298

5/14

124

248

372

6/14

149

298

447

7/14

174

347

521

8/14

199

397

596

9/14

223

447

670

10/14

248

496

745

11/14

273

546

819

12/14

298

596

894

13/14
1

323
347

645
695

968
1042

1X

2X

3X

𝑓𝑟

3.6

7.1

10.7

5.8

11.6

17.3

6.1

12.3

18.4

𝑓1

12.4

24.8

37.2

16.3

32.5

48.8

𝑓𝑐
𝑓𝑝
𝑓𝑠

The element spin speeds and their superharmonics are contained in the first 50 Hz of the planetary
mesh spectrum, shown in Fig.42(a). The spin speed of the sun has the largest amplitude because
the planetary mesh is driven by its constant angular velocity. The impacts in the fixed axis pair are
transmitted to the elements in the planetary mesh through the ring. This force propagation causes a
reduction in the amplitude of the gear 1 spin speed and its superharmonics when observed from
the planetary mesh spectrum.

The planetary gear mesh frequency is modulated by the sun spin speed and its subharmonics,
shown in Fig.42(b). The sun spin speed subharmonics are a function of the number of planet gears
calculated in Table 8. The subharmonics create wide 50 Hz sidebands around the gear mesh
frequency. The fixed axis meshing frequency appears in the planetary mesh spectrum when a
chipped tooth is included on the sun. The magnitude of the effect is reduced when an eccentric
tooth is included on a planet.
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Table 8. Frequencies of Fig.42
Point

Hz

The fixed axis gear mesh frequency is modulated by

GMFabc ± ⅓fs

1

215

the sun spin speed and its subharmonics although it is

GMFabc ± ⅔fs

2

221

not included in the planetary mesh elements. The

GMFabc ± fs

3

226

GMFabc ± 2fs

4

242

GMF12 ± ⅓fs

5

352

GMF12 ±⅔fs

6

358

new and important vibration signature of the defected

GMF12 ± fs

7

363

gear train.

GMF12 ± 2fs

8

380

2(GMFabc) ± ⅓fs

9

424

2(GMFabc) ± ⅔fs

10

430

2(GMFabc) ± fs

11

435

2(GMFabc) ± 2fs

12

451

Sideband

presence of GMF12 in the planetary mesh FFT
indicates damage on a sun tooth. This is a potentially

5.8 Joint time-frequency analysis (JTFA)
In order to demonstrate how the frequency content of force changes with time a joint timefrequency analysis (JTFA) is performed based on transient start-up conditions. Fig.43 is created
from the force history between gear 1 and the external teeth of the ring. The fixed axis force vector
is chosen for study because of its unique interaction with the ring. The ring makes direct contact
with all elements in the transmission except the sun. Therefore, the force vector between gear 1
and the ring contains information about the dynamics of the entire system. An exponential step of
t

the form ω(1 − e �τ ) is applied to both the sun and gear 1 to represent a characteristic electric

motor. The magnitudes are -78.0 rad/s for gear 1, and 102.1 rad/s for the sun, with τ = 1000 ms.

A resistive torque is applied to both the carrier assembly and the ring, with a magnitude around
one percent of the element's torque at steady-state. Aliasing issues are prevented by using a large
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number of integration steps and a long simulation duration of 4 seconds. Spectrum leakage is
reduced by overlapping a sliding time sample of 100 ms by 98% and applying a Hamming
window to each sample.

Fig.43. Three dimensional FFT of force magnitude in the fixed axis mesh for
prescribed backlash and chipped sun with an exponential step
angular velocity on both sun and gear 1

Due to the nonlinearity caused by the interaction of the damaged tooth and different backlash, a
large number of contact events are created which occur at nearly random intervals. The random
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nature of the impacts produces a frequency domain with some noise. The low amplitude peaks
observed between 1250 Hz and 1450 Hz continue until approximately 5000 Hz, with frequencies
greater than 5000 Hz near zero.

At 760 ms the second harmonic of the fixed axis gear mesh GMF12 is identified as the largest peak
at 650 Hz. This value is less than the 695 Hz listed in Table 7 because the system has not
accelerated to its full operating speed at τ = 1000 ms. The 3X(sun) speed is a strong excitation
because of the chipped sun tooth. The damaged tooth rotates through a planet mesh three times per
revolution. Therefore, the 3X(sun) speed is not a harmonic but rather the fundamental excitation of
the chipped sun. The four largest peaks along the 760 ms line are modulated by the 3X(sun)
frequency. The second harmonic of 2(GMF12) dominates the spectrum through the 650 to 1000 ms
range with sidebands also equal to 3X(sun). The sidebands increase in frequency along with
system speed to their final value of 48.8 Hz at 1000 ms. An increase in the separation between
peaks is observed. Along the 1000 ms line the third harmonic of 3(GMF12) = 1042 Hz is present
with sidebands of 3X(sun). The fourth harmonic of 4(GMFabc) = 838 Hz falls in this region with
magnitudes comparable to the GMF12 harmonics. It notable that the fundamental GMF12, GMFabc,
and 2(GMFabc) are not the dominant frequencies during start-up.

The curvature in the spectral lines in the time domain is due to the acceleration of the ring. As the
system accelerates from rest, the first contacts occur from gear 1 to the ring, and from the sun to
each planet. The ring and planets oscillate within their backlash at high frequency because velocity
is not prescribed on these elements. The ring accelerates away from the direction of contact up to
350 Hz, causing the contacts with gear 1 and the planets to occur at increasingly longer intervals.
The ring's acceleration away from the direction of contact causes the frequency of all spectral lines
to decrease. The opposite occurs during the interval of 350 ms to 450 ms. Here the ring decelerates
slightly, decreasing the interval between contacts and causing an increase in spectral frequency.
The magnitude of oscillation in the ring's acceleration diminishes with time with all spectral lines
remaining straight for t > τ .
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6. CONCLUSIONS
6.1 Conclusion

A non-linear quasi-static contact analysis has been performed on two finite element models. The
baseline investigates the dynamic engagement cycle with perfect involute profiles and center
distance backlash. The second model includes the effect of a fatigue crack emanating from the
pinion tooth root. The force and resulting Von-Mises stress varies as the contact pair alternates
between one and two through the dynamic engagement cycle. The fatigue crack increases force
and resulting stress by 99% at the critical tip-contact configuration.

A non-linear multi-body dynamic software model has been developed for a two stage crank-slider
mechanism to demonstrate dynamic loading on gear teeth with defects during transient, start-up,
and steady-state operation. The stiffness, force exponent, damping, and friction coefficients for the
ADAMS impact force algorithm has been presented. The dynamic behavior of the mechanism's
intermediate shaft is shown to be a superposition of the impact forces acting in each mesh. The
geometric profile error of a chipped tooth on the input pinion causes a delay in the contact forces
in the second stage. A joint time-frequency analysis (JTFA) on a transient start-up simulation
reveals spectral components which increase in both frequency and magnitude as the crank
accelerates through its operating speed. Fast Fourier Transform (FFT) analysis of steady-state
operation demonstrates that the spectrum includes the gear mesh frequencies and their harmonics.

A practical differential planetary gear train which combines two inputs and one output has been
investigated using a non-linear multi-body dynamics model. To avoid interference and undercut
the backlash between the sun-planet and planet-ring meshes are precisely defined. When the
transmission operates with a fixed ring and undergoes free vibration from a near symmetrical
position, six contact forces are potentially active. The magnitude of the contact forces depend on
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the time varying contact ratios of each element. The duration of the contact event decreases with a
freely rotating ring and applied initial velocity.

Step torques of opposite directions to each input shaft closely model the constraints and loading
conditions of realistic operation. The dynamics of the differential mode are shown to be less
destructive to the sun. The characteristics observed in the time and frequency domains are due to
the interaction of many components of the differential planetary transmission. Fast Fourier
Transform (FFT) analysis shows harmonics of the gear mesh frequency with varying sideband
modulation. A joint time-frequency analysis (JTFA) during start-up reveals unique vibration
patterns when the contact forces increase during acceleration.

6.2 Future research

The finite element model has been validated and prepared for a torsional stiffness formulation.
Results of this analysis can be compared to experimental vibration data collected with a GE
ADRE SXP 408 data acquisition system installed with a two-stage fixed axis gearbox. This DAQ
includes a wide variety of signal processing capabilities and offers the potential to investigate new
parameters of interest. Multi-body dynamic software models and MATLAB codes are currently
being developed to make the valuable comparisons between simulation and experiment. The
results developed from these sources will be combined into a formal publication.

53

BIBLIOGRAPHY
1.

Dubowsky, S., Freudenstein, F., “Dynamic Analysis of Mechanical Systems With Clearances,
Part 1: Formulation of Dynamic Model”, ASME Journal of Engineering for Industry, Vol. 93,
Feb. 1971, pp. 305-309.

2.

Dubowsky, S., Freudenstein, F., “Dynamic Analysis of Mechanical Systems With Clearances,
Part 2: Dynamic Response”, ASME Journal of Engineering for Industry, Vol. 93, Feb. 1971,
pp. 310-316.

3.

Azar, R. C., Crossley, F. R. E., “Digital Simulation of Impact Phenomenon in Sour Gear
Systems”, ASME Journal of Engineering for Industry, Vol. 99, Aug. 1977, pp. 792-798.

4.

Yang, D.C.H., Sun, Z.S., “A Rotary Model for Spur Gear Dynamics”, Transactions of the
ASME, Journal of Mechanisms, Transmissions and Automation in Design, Vol. 107, Dec.
1985, pp. 529-535.

5.

Özgüven, H.N., Houser, D.R., “Mathematical Models used in Gear Dynamics – A Review”,
Journal of Sound and Vibration, Vol. 121(3), 1988, pp. 383-411.

6.

Parey, A., Tandon, N., “Spur Gear Dynamic Models Including Defects: A Review”, The
Shock and Vibration Digest, Vol. 35, No. 6, Nov. 2003; pp. 465-478.

7.

Dalpiaz, G., Rivola, A., Rubini, R., “Effectiveness and Sensitivity of Vibration Processing
Techniques for Local Fault Detection in Gears”, Mechanical Systems and Signal Processing,
Vol. 14(3), 2000, pp. 387-412.

8.

Parey, A., El Badaoui, M., Guillet, F., Tandon, N., “Dynamic Modeling of Spur Gear Pair and
Application of Empirical Mode Decomposition-based Statistical Analysis for Early Detection
of Localized Tooth Defect”, Journal of Sound and Vibration Vol. 294, 2006, pp. 547–561.

9.

Ebrahimi, S., Eberhard, P., “Rigid-elastic Modeling of Meshing Gear Wheels in Multi-body
Systems”, Multi-body System Dynamics, Vol. 16, 2006, pp. 55–71.

10. Fakhfakh, T., Chaari, F., Haddar, M., “Numerical and Experimental Analysis of a Gear
System with Teeth Defects”, The International Journal of Advanced Manufacturing
Technology, Vol. 25, 2005, pp. 542–550.
11. Ciglariˇc, I., Kidriˇc, A., “Computer-aided Derivation of the Optimal Mathematical Models to
Study Gear-pair Dynamics by Using Genetic Programming”, Structural and Multidisciplinary
Optimization, Vol 32, 2006, pp. 153–160.
12. Pimsarn, M., Kazerounian, K., “Pseudo-interference Stiffness Estimation, a Highly Efficient
Numerical Method for Force Evaluation in Contact Problems”, Engineering with Computers,
Vol.19, 2003, pp. 85–91.
13. Meagher, J., Wu, X., Kong, D., Lee, C., “A Comparison of Gear Mesh Stiffness Modeling
Strategies”, IMAC XXVIII a Conference on Structural Dynamics, Society for Experimental
Mechanics, Jacksonville, Florida USA, February 1–4, 2010.
14. Kong, D., Meagher, J., Xu, C., Wu, X., Wu, Y., “Nonlinear Contact Analysis of Gear Teeth
for Malfunction Diagnostics”, IMAC XXVI a Conference on Structural Dynamics, Society for
Experimental Mechanics, Orlando, Florida USA, February 4–7, 2008.
15. MSC Inc., MSC ADAMS reference manual.
54

16. Lin, J., Parker, R. G., “Parametric Instability of Planetary Gears under Mesh Stiffness
Variation”, Journal of Sound and Vibration, 2002, Vol. 249, pp. 129-145.
17. Lin, J., Parker, R.G., “Analytical Characterization of the Unique Properties of Planetary Gear
Free Vibration”, ASME Journal of Vibration and Acoustics, Vol. 121, July 1999, pp. 316-321.
18. Guo, Y., Parker, R. G., “Dynamic Modeling and Analysis of a Spur Planetary Gear Involving
Tooth Wedging and Bearing Clearance Nonlinearity”, European Journal of Mechanics
A/Solids, 2010, Vol. 29, pp. 1022-1033.
19. Parker, R. G., Wu, X., “Vibration Modes of Planetary Gears with Unequally Spaced Planets
and an Elastic Ring Gear”, Journal of Sound and Vibration, 2010, Vol. 329, pp. 2265-2275.
20. Guo, Y., Parker, R. G., “Purely Rotational Model and Vibration Modes of Compound
Planetary Gears”, Mechanism and Machine Theory, 2010, Vol. 45, pp. 365–377.
21. Drago, R. J., “Fundamentals of Gear Design”, 1988.
22. Li, H., Li, G., “Gear Mechanism Design and Application”, 2007 (in Chinese).
23. Rao, Z., “Planetary Gear Transmission Design”, 2003 (in Chinese).
24. Machinery's Handbook 28th Larger Print Edition.
25. Simulia Inc., Abaqus Version 6.7 Documentation.
26. Wu, X., Meagher, J., Sommer, A., “A Differential Planetary Gear Model with Backlash and
Teeth Damage”, IMAC XXIX a Conference and Exposition on Structural Dynamics, Society
for Experimental Mechanics, Jacksonville, Florida USA, Jan. 31–Feb. 3, 2011.
27. Sommer, A., Meagher, J., Wu, X., “An Advanced Numerical Model of Gear Tooth Loading
from Backlash and Profile Errors”, IMAC XXIX a Conference and Exposition on Structural
Dynamics, Society for Experimental Mechanics, Jacksonville, Florida USA, Jan.31–Feb.3,
2011.
28. Sommer, A., Meagher, J., Wu, X., “Gear Defect Modeling of a Multiple-Stage Gear Train”,
Modelling and Simulation in Engineering, 2011, Vol. 2011, Article ID 754257, 8 pages,

55

APPENDIX

56

A. STRESS ANALYSIS OF SPUR PAIR USING LEWIS-BENDING
AND AGMA METHODOLOGY

Two industry accepted methods which define the stress on dynamically engaging gear teeth are
presented. The simplest approach is the Lewis-bending equation,

𝜎𝑙𝑒𝑤𝑖𝑠 =

𝐾𝑣 𝑊 𝑡
𝑚𝐹𝑌

The Lewis-bending results include the assumption that both gears have a cut or milled profile,
calculated in Table A.1. This formulation yields an appropriate stress magnitude and is used for
comparison with the FEM results.

Table A.1. Tooth stress predicted by the Lewis-bending equation
Kv

Wt
lbf

m
in/tooth

F
in

Yfactor

σLewis
ksi

Pinion

1.095

767

0.1

1.0

0.334

25.2

Gear

1.095

1394

0.1

1.0

0.362

42.2
σavg = 33.7

A more rigorous approach is the AGMA methodology. AGMA evaluates stress with respect to
infinite life, or 107 cycles. Two types of failure modes are considered, failure due to bending
fatigue using quantities σall , σact , SF , and failure due to pitting through quantities, σc,all , σc,act , SH.
The equations are defined using Hertzian contact theory and a number of geometric,
manufacturing, loading, and environmental factors.

𝜎𝑎𝑙𝑙 =

𝑆𝑡 𝑌𝑁
𝑆𝐹 𝑌𝜃 𝑌𝑍

𝜎𝑐,𝑎𝑙𝑙 =

𝑆𝑐 𝑍𝑁 𝑍𝑊
𝑆𝐻 𝑌𝜃 𝑌𝑍

𝑆𝐹 =
𝑆𝐻 =

𝑆𝑡 𝑌𝑁
𝐾𝑇 𝐾𝑅 𝜎𝑎𝑐𝑡

𝑆𝑐 𝑍𝑁 𝐶𝐻
𝐾𝑇 𝐾𝑅 𝜎𝑐,𝑎𝑐𝑡
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𝜎𝑎𝑐𝑡 = 𝑊 𝑡 𝐾𝑜 𝐾𝑣 𝐾𝑠
𝜎𝑐,𝑎𝑐𝑡

1 𝐾𝐻 𝐾𝐵
𝐹𝑚𝑡 𝑌𝐽

𝐾𝐻 𝑍𝑅
= 𝑍𝑒 �𝑊 𝐾𝑜 𝐾𝑣 𝐾𝑠
�
𝐹𝑑𝑝 𝑍𝐼
𝑡

1�
2

The following assumptions are made for both gears: carburized through hardened grade 3 steel,
uncrowned teeth, straddle mounted, open gearing, and the temperature of the lubrication is kept
within its recommended range.

AGMA is usually considered conservative because it evaluates stress with respect to infinite life.
Automotive transmissions for instance, do not fall into the infinite life category. Safety factors less
than one for both bending and contact fatigue are noted with this criteria in mind. The results of
the AGMA methodology are calculated in Table A.2 and Table A.3.

Table A.2. AGMA pinion tooth stress in bending
and contact fatigue for infinite life
Ko

ZR

Ks

CH

YN

YZ

Yϴ

Ko

1

1

1

1

1

1

1

1

Cpf

Km

KH

YJ

-0.003

1.257

1.257

0.340

1/2

KT

KR

ZN, ZW

Ze psi

1

1

1

2300

ZI

Kv

σall ksi

σact ksi

SF

σc,all ksi

σc,act ksi

SH

0.107

2.499

75

142

0.529

175

3220

0.295

Table A.3. AGMA gear tooth stress in bending
and contact fatigue for infinite life
Ko

ZR

Ks

CH

1

1

1

1
1/2

Ze psi

YN

YZ

Yϴ

Ko

1

1

1

1

Cpf

Km

KH

YJ

-0.009

1.251

1.251

0.367

KT

KR

ZN, ZW

1

1

1

2300

ZI

Kv

σall ksi

σact ksi

SF

σc,all ksi

σc,act ksi

SH

0.107

2.056

75

195

0.384

175

338

0.268
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B. ABAQUS CAE SPUR PAIR TWO-DIMENSIONAL FINITE ELEMENT
MODEL USING SOLIDWORKS CAD GEOMETRY

B.1 Solidworks
Create a new part. File → New → Part
Draw the pinion profile as a sketch only, do not extrude.

Save sketch in STEP file format.
File → Save As → type: STEP (*.stp)
Options button, choose these settings.

Name the file "Spinion.stp", Click OK → Save
Using the same process create a new part and sketch the gear with name "Sgear.stp".
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B.2 ABAQUS CAE
Create a new model. File → New → Model
Import the sketch. File → Import → Sketch

Select the pinion sketch, click OK. Error message will appear.

Choose dismiss. This error is irrelevant, the sketch has imported correctly.
Using same process import the gear sketch into the model.
Two sketches are in the model tree.
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Create a new part. Part → Create
Choose these settings, click Continue
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Click open sketch icon.

Click OK. Translate the sketch the desired center distance to create

backlash, or click Done. Using the same process save the gear sketch to a new part.

Two parts are in the model tree.
Assemble the parts and mesh using standard procedures.
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C. MSC.ADAMS EXTERNAL SPUR PAIR BACKLASH MODEL
USING SOLIDWORKS CAD GEOMETRY

C.1 Solidworks
Using MATLAB codes generate two external spur gear profiles with design parameters,

m=2
Z1 = 23 teeth
Z2 = 31 teeth
F = 10 mm
Pinion bore diameter = 20 mm
Gear bore diameter = 30 mm

Save As → parasolid (*.x_t) with filenames "pinion23.x_t" and "gear31.x_t".

C.2 ADAMS import
Create a new model with default settings.

File → Import
Choose the settings by right-click → Browse
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Change the grid settings. Settings → Working Grid
Right-click part, Rename → "pinion23"
Right-click part, Modify → assign mass using material type: steel
Press Shift + I for an isometric view.
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C.3 MATLAB
Backlash is created using operational radii calculated by the center distance method.
Using MATLAB codes,

C.4 ADAMS simulation
Left-click the pinion to select the part, it will become highlighted.
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Edit → Move , Translate to the operational radius in the + y-direction by entering a value and
clicking

. Create a revolute joint at the CM location of the pinion, choose "2 Bod- 1 Loc" and

"Normal to Grid." The pinion is now in the correct location. Using the same process translate the
gear to its operational radius and create a second revolute joint.

Right-click, Appearance → change icon size.
Press Shift + F for a front view. The model should have noticeable backlash.

Define a restitution contact force between the pinion and gear using default settings.
Right-click pinion → Modify → add an initial velocity to the CM x-axis.

Create a new pinion23 marker at the part's CM location, click

Add to Part. Translate this

marker in the y-direction +20 mm (arbitrary) using Edit → Move, this is the first marker. Create a
new ground marker in the same location, this is the third marker. The second marker will be the
part CM.
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Build → Measure → Angle → New and enter the information using right-click → Browse. The
first and third marker names may differ, the second marker should be the part CM. Using same
process create an angle measure for the gear's rotation. Set the simulation to End Time 0.01 and
Steps 1000, click Run.

The involute profile can be used to show that backlash measured along the common normal line
has the relationship,
𝐵 > 𝑅𝑏1 𝜃1 − 𝑅𝑏2 𝜃2 > −𝐵
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Build → Measure → Function → New, and enter the following.

Open the ADAMS Post-Processor by clicking

. An overlay plot of angular position is shown

using Add Curves. Source → Objects to view the angular velocity.

The inertia of the 23 tooth pinion is only slightly less than the 31 tooth gear. A 20:50 mesh ratio
has a larger difference in inertia. The variation in the pinion and gear dynamics is more evident
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with the 20:50 pair, the results are in close agreement with literature [4]. For comparison, a
geometry with an eccentric pinion, and an eccentric pinion meshing with a worn gear, is shown in
the plots. Discussion of kinematic motion, torque, and step functions is discussed in Appendix D.
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C.5 ADAMS examples
Initial velocities.

Input torque, resistive torque, and initial velocities.
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Sinusoidal input torque characterizes system.
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D. MSC.ADAMS KINEMATIC ANALYSIS OF PLANETARY
TRANSMISSION USING SOLIDWORKS CAD GEOMETRY

D.1 Solidworks
Create a new part.
Set the dimensional tolerances and image quality to their maximum values.
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Use these same high tolerance settings for the assembly. The gear teeth are not in contact and all
components are mated correctly. Save assembly as type parasolid .x_t.

D.2 Considerations for backlash of planetary gears

The center distance method is not acceptable for the
internal meshes of planetary transmission. One
approach to achieve a desired backlash is to modify the
position of the involute profile of the planet. First
create the correct tooth, then linearly translate the
profile one half the desired backlash. This will generate
equivalent backlash in the sun-planet and planet-ring
meshes.
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D.3 ADAMS
Create a new model with default settings. This step must be done before importing the model.

In the Command Window enter:
defaults geometry display_tolerance_scale = 0.01
for units of mm. For English units the desired tolerance is 0.0005 in.

74

75

Decrease the simulation time by changing the solver thread count to 4. Import the parasolid
assembly. Right-click → Browse. Right-click and assign mass to all parts, a new CM marker is
generated.
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A keyway is a realistic feature that creates an asymmetrical mass distribution in the plane of
rotation. Consider the orientation of the part's CM triad. Add revolute and fixed joints to the
correct bearing locations by building new markers with the desired orientation.

The model can be validated by applying motion to an input shaft.
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The motion is a kinematic constraint that defines the rotation of the element as a function of time.

n x = n xb + n xa = 36.5 rad/s
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Applying initial velocities is discussed in Appendix C.4. For the application of torque, a step
function can be scaled to represent an electric motor.
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Solver time is reduced by deselecting
Update graphics display and animating
the completed simulations. Each time a
simulation result is viewed in the
postprocessor the computed variables
are saved to the current .bin file. The
size of the .bin increases rapidly when
postprocessing. For aview2010 when the
file size exceeds 250 MB the model may
lose integrity and generate erroneous
errors.

One approach to reduce file size is to export the .bin as a .cmd file, then create a new model and
import the original. Define the defaults geometry display_tolerance_scale parameter from the
Command Window before importing the .cmd file.

.
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The plots of previous .bin databases can be retained by exporting the curves in spreadsheet format,
then importing them as numeric data.

Change the independent axis to Data. MEA_1 is time, the other measures are the retained curves.

D.4 ADAMS contact algorithm
ADAMS offers two algorithms for the contact force: impact and restitution. The impact algorithm
is numerically robust and best suited for multiple simultaneous contact events. The force vector
between two objects is calculated using a classical mechanics model. The algorithm requires both
objects to share a three dimensional penetration zone. In contrast, the restitution algorithm
prohibits this unrealistic surface penetration between objects. The contact is modeled as an
impulse with an energy penalty assessed on each event. Significant computational finesse is
required to apply the restitution model in a planetary transmission. A fixed axis 23:31 external
spur pair with a restitution coefficient of 1 is discussed in Appendix C.4.
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